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                Select documents
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        Users trust to manage documents on pdfFiller platform

        
                                                
                        65.5K+

                        documents added daily
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from templates
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                                                                        Unlock PDF and Merge PDF for Windows is a powerful feature that allows you to effortlessly unlock and merge PDF documents. With this feature, you can easily manage and organize your PDF files in just a few clicks.

                                                                                                Key Features:

                                                                                                
                                                                    
                                        Unlock password-protected PDF files

                                    

                                                                    
                                        Merge multiple PDF documents into a single file

                                    

                                                                    
                                        Drag and drop functionality for easy file upload

                                    

                                                                    
                                        Simple and intuitive user interface

                                    

                                                                    
                                        Fast and efficient processing

                                    

                                                                    
                                        High-quality output files

                                    

                                                            

                                                                                                Potential Use Cases and Benefits:

                                                                                                
                                                                    
                                        Unlock PDF files to access content or make edits without the password

                                    

                                                                    
                                        Merge PDF files to combine multiple documents into a single file for easier sharing or distribution

                                    

                                                                    
                                        Organize and streamline your PDF files for improved productivity

                                    

                                                                    
                                        Save time and effort by avoiding the need to manually unlock or merge PDFs

                                    

                                                                    
                                        Maintain the integrity of your PDF files with high-quality output

                                    

                                                            

                                                                                                Unlock PDF and Merge PDF for Windows offers a simple and convenient solution to your PDF management needs. Whether you need to unlock password-protected files or merge multiple documents into one, this feature provides a user-friendly interface and efficient processing. With its drag and drop functionality, you can easily upload your PDFs and create high-quality output files. Unlock and merge your PDFs with ease today!

                                                            

            

        

    
    
    
        
            
                All-in-one PDF software
            

            
                A single pill for all your PDF headaches. Edit, fill out, eSign, and share – on any device.
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        How to Unlock and Merge PDFs on Windows with pdfFiller
    


            Unlocking and merging PDF files on Windows using pdfFiller is a simple and efficient process. Follow the step-by-step guide below to make the most of the Unlock PDF and Merge PDF for Windows feature:

                
                        
                                    01

                    
                        Launch the pdfFiller application on your Windows device.
                    

                            

                        
                                    02

                    
                        Click on the 'Unlock PDF' option in the main menu.
                    

                            

                        
                                    03

                    
                        Select the PDF file you want to unlock by clicking on the 'Choose File' button.
                    

                            

                        
                                    04

                    
                        Once the file is uploaded, pdfFiller will prompt you to enter the password for the locked PDF. If you don't have the password, you can try using the 'Forgot Password' option or contact the document owner for assistance.
                    

                            

                        
                                    05

                    
                        After entering the password, click on the 'Unlock PDF' button to remove the password protection from the file.
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                        Once the PDF is unlocked, you can proceed to merge multiple PDF files together.
                    

                            

                        
                                    07

                    
                        Click on the 'Merge PDF' option in the main menu.
                    

                            

                        
                                    08

                    
                        Select the PDF files you want to merge by clicking on the 'Choose File' button for each file.
                    

                            

                        
                                    09

                    
                        Arrange the files in the desired order by dragging and dropping them in the merge queue.
                    

                            

                        
                                    10

                    
                        If needed, you can also add additional PDF files by clicking on the 'Add More Files' button.
                    

                            

                        
                                    11

                    
                        Once you have selected and arranged all the files, click on the 'Merge' button to combine them into a single PDF document.
                    

                            

                        
                                    12

                    
                        Wait for the merging process to complete. The time taken will depend on the size and number of files being merged.
                    

                            

                        
                                    13

                    
                        After the merge is finished, you can download the merged PDF file to your Windows device or save it to your pdfFiller account for easy access in the future.
                    

                            

                    

                By following these steps, you can easily unlock and merge PDF files on Windows using pdfFiller. Enjoy the convenience and efficiency of managing your PDF documents with this powerful feature!

            

    
                
    
        What our customers say about pdfFiller

        See for yourself by reading reviews on the most popular resources:
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                                    Very easy program to work with and edit if you need to make changes and also cost effective, you don't have to pay the realtor half the rent by doing it yourself.
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                                    This is a remarkable Utility for working with pdf formats.  It saves time and contains excellent applications to meet and complete many business tasks.
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                    Get a powerful PDF editor for your Mac or Windows PC

                    Install the desktop app to quickly edit PDFs, create fillable forms, and securely store your documents in the cloud.

                    
                        Download pdfFiller for Mac OS

                        Download pdfFiller for Windows PC
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                    Edit and manage PDFs from anywhere using your iOS or Android device

                    Install our mobile app and edit PDFs using an award-winning toolkit wherever you go.

                    
                        Download from App Store

                        Download from Google Play
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                    Get a PDF editor in your Google Chrome browser

                    Install the pdfFiller extension for Google Chrome to fill out and edit PDFs straight from search results.

                    Download from Chrome Web Store

                

            

        

    


    
    
        
            
                
                    pdfFiller scores top ratings in multiple categories on G2
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            Related searches to Unlock PDF and Merge PDF for Windows
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            List of extra features
        

        
                            
                    Unlock and Remove Password from PDF for free
                

                            
                    Unlock and Secure PDF File for free
                

                            
                    Unlock and Password Protect PDF for free
                

                            
                    Unlock and Encrypt PDF for free
                

                            
                    Unlock and Prevent Printing PDF for free
                

                            
                    Unlock and Compress PDF for free
                

                            
                    Unlock and Convert PDF for free
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                                    For pdfFiller’s FAQs
                            

            
                                    Below is a list of the most common customer questions. If you can’t find an answer to your question, please don’t hesitate to reach out to us.
                            

            
                                    
                        
                            
How can I unlock a PDF file for free?
                        

                                                    Drag and drop your document in the PDF Password Remover.
Confirm that you have the right to the file and click 'Unlock PDF!'.
The decryption process should start right away.
Modify your PDF further, or click 'Download File' to save the unlocked PDF.


                                            

                                    
                        
                            
How do I remove protection on a PDF?
                        

                                                    Choose Tools > Protect > Encrypt > Remove Security. Remove Security: The options vary depending on the type of password security attached to the document. If the document has a Document Open password, click OK to remove it from the document.

                                            

                                    
                        
                            
How do I unlock a locked PDF in Windows?
                        

                                                    Click CHOOSE FILE. It's a green button on the right side of the page.  
Select your PDF file. In the window that opens, go to the location in which your PDF is stored, then click the PDF once to select it.
Click Open.  
Enter the user password.  
Click UNLOCK.  
Click VIEW & DOWNLOAD IN BROWSER.


                                            

                                    
                        
                            
How do I merge PDF files that are locked?
                        

                                                     File→Create for creating a new PDF file.
 Choose Combine Files Into a Single PDF option.
 Click on Add File, add all the PDF files you want to merge.
 Add password of the locked PDF files.
 Click on Combine.
 File→Saves to save the PDF file.


                                            

                                    
                        
                            
How can I unlock a PDF for free?
                        

                                                    Drag and drop your document in the PDF Password Remover.
Confirm that you have the right to the file and click 'Unlock PDF!'.
The decryption process should start right away.
Modify your PDF further, or click 'Download File' to save the unlocked PDF.
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